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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
(Approved by AICTE, New Delhi & Affiliated to INTUK, Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272

Valluru,

Date: 18-11-2021
To
Dr.P.Surendra Kumar,

Associate Professor, Bapatla Engineering College,
Bapatla.

Dear Sir,

Subject: Inviting for Certificate program “Antenna Design using HFSS”- Reg.

Greetings from RISE Krishna Sai Gandhi Group of Institutions, Ongole

As per the discussion with Dr.K.V.Subrahmanyam , Principal, of our Institute, I hereby
take this opportunity to invite you to conduct the Certificate program on Antenna Design using
HFSS “ From 06-12-2021 to 10-12-2021.

You are requested to interact and provide guidance to our IV B.Tech students, who are
looking forward to their bright career ahead. I will feel honored by your gracious presence at our

organization. I believe that your lecture will help our students and faculty members to explore
knowledge.

Thanking you in anticipation.

Y ours sincerely,
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PRINCIPAL
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o i - -~ -
Vel LURU: OHGOLE,

TCIPAL

(1A SAI GANDT!

n



Dr. P. Surendrakumar

Associate Professor

ECE

Bapatla Engineering College, Bapatla.
Email: mailme_surendranitk@yahoo.co.in

Biography

Dr. P. Surendra Kumar, received his B.Tech degree from V.R. Siddhardha Engineering College,
Vijayawada and M.Tech in Digital Electronics and Advanced communications (DEAC) from
National Institute of Technology (NIT) Surathkal Karnataka in the Department of Electronics and
Communication Engineering, received Ph.D. in Microstrip antenna design from Nagarjuna
University, Guntur, (AP) He has 15 years of teaching experience as an Associate professor in
Bapatla Engineering College, Bapatla. His areas of interests are Microstrip Antenna design, MIMO
antenna and antenna design for 5G and 6G wireless applications. He has published 30+ research
papers in top journals and conferences.

Awards & Honors

1%
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Received 1% Best Research paper award from IEEE Hyderabad section (InCAP2018).

. Received 3'9 Best Research paper award from 1ISc Bangalore, INDICON2016.

Received Best Young Researcher Award from Global Education (GECL2Kk19).

. Nominated for Young Scientist Award-2018 from innovative research developers.

Reviewer for SCI Journal (International Journal of RF and Microwave Computer-Aided
Engineering, John Wiley & Sons Periodicals, Impact factor:1 .306).
Published research papers in IISc Bangalore, IIT Roorkee and IIT Bhubaneswar.

. Published IEEE SCI journal research papers in IEEE Antennas and Propagation.

Reviewer for IEEE International Conference.

. Received UGC Minor research project of worth 2.3 Lakhs.

10. Reviewer for IEEE Access.

Selected Publications: latest 5 publications

s
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P. Surendrakumar, “Miniaturization of patch antenna using partially loaded non-uniform
meta-surfaces with metamaterial,” JEEE Antennas and Propagation Magazine, Vol.61,
Issue. 01, Feb 2019.

P. Surendrakumar, “Design of Triple Frequency Vertex Feed Pentagonal slot antenna with
E-slot for WiMAX and WLAN Applications,” IEEE Antennas and Propagation
Magazine, Vol.60, Issue. 03, June2018.

P. Surendrakumar, Triple-UWB Millimeter-wave MIMO Antenna with Improved
Isolation for 5G Wireless Applications, IEEE Indian conference on Antennas and
Propagation 2019, Dec21.

P. Surendrakumar, A Compact Hexa-Band and UWB Antenna Using. Heptagon and
Nonagon Rings with Vertex Feed, IEEE Indian Conference on Antennas and
Propagation, Dec 2018.

P. Surendrakumar, “Design of a Miniaturized triple-band antenna with conductor backed
metasurfaces CPW-fed for 5G Wireless applications ndian council hosted by an
IEEE section, IEEE Bangalore, Dec 2017
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™5 RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS

(Approved by AICTE, New Delhi & Affiliated to INTUK, Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

—
y

PROPOSAL FORM

SUB: Certificate program.

TO THE SECRETARY/CORRESPONDENT THROUGH PRINCIPAL FOR KIND
APPROVAL

NAME OF THE INSTITUTION

Rise Krishna Sai Gandhi Group of Institutions

Electronics & Communication Engineering

2 NAME OF THE DEPARTMENT
3 | TITLE OF THE PROGRAMME AP
4 NAME OF THE PROGRAMME Certificate program on “ Antenna Design using
HFSS”
5 OBJECTIVE OF THE PROGRAMME | To bring the exposure in the Antenna Design.
Dr.P.Surendra Kumar,
6 DETAILS OF RESOURCE Associate Professor, Bapatla Engineering College,
PERSON(S)& CV ATTACHED. Bapatla.
7 PROPOSED DATE(S)/ACADEMIC 06-12-2021 to 10-12-2021
YEAR
8 DURATION OF THE PROGRAMME | FIVE DAY
9 VENUE MPMC Lab
10 TARGETS IV ECE students
11 No. OF PARTICIPANTS 126 Students
12 | REGISTRATION FEE Free
NAME OF PROGRAMME CO :
13 ORDINATOR(S) Mr. R.V Kiran Kumar
14 NAME OF THE STUDENTS 1.Ms. Jolla Jyoshna ( 188B1A0414)
COORDINATOR(S)

2.Mr. Gunimini Sai ( 198B5A0408)
=2
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
(Approved by AICTE, New Delhi & Affiliated to INTUK, Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

15 SOURCE OF FUND IDENTIFIED Management
16 MANAGEMENT CONTRIBUTION YES
REQUIRED
17 PROPOSAL PREPARED BY Mr. R.V.Kiran Kumar (CO-ORDINATOR)
1
: 8/ \/ 1 %‘,wr‘\ M
Coo ator =

"EAD OF THE DEPARTMENT
partment of F CE

leS§ K.n'shna Sai Gandhi Group
o lnstm:ttons.VALLURU.A.P.-523 272
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3 RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
(Approved by AICTE,New Delhi & Affiliated to INTUK ,Kakinada)

NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Vallury,
Date: 04-12-2021.

CIRCULAR

This is to inform IV B.Tech students and faculty that there will be a 5-Day Certificate
program on“Antenna Design using HFSS”from 06-12-2021 to 10-12-2021by Dr.P.Surendra

Kumar, Associate Professor, Bapatla Engineering College,Bapatla.

SV % C*‘A
HEAD OF THE DEPARTMENT
Copy to: Department of EC.E
= RISE Xrishna Sai Gandhi Graun
Principal of istiutians VALLURU AP-323 212
Staff Circular
€ Students of ECE 1V year

ECE Department Notice Boards
=
PRINCIPAL
RISE KRISHN A SM G MEDH
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS

(Approved by AICTE,New Delhi & Affiliated to INTUK,Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate Program on “Antenna Design using HFSS”

Date: 06"to 10™"Dec 2021

SCHEDULE FROM 06-12-2021 TO 10-12-2021

S.No Program List Timing
From To
DAY - 01 (06-12-2021)
1 Program started 09.00 AM --
2 Lamp lighting 09.00 AM 09.10 AM
3 Principal speech 09.10 AM 09.25 AM
4 HOD Introduction about Antenna Design 09.25 AM 09.35 AM
5 Tea Break 09.35 AM 10.00 AM
6 Introduction to Antennas 10.00 AM 01.00 PM
7 Lunch Break 01.00 PM 01.45PM
8 Antenna Architecture ‘ 01.45PM 05.00 PM
DAY - 02 (07-12-2021)
9 Introduction to HFSS 09.00 AM 12.15PM
10 | Lunch Break 12.15 PM 01.00 PM
11 | Antenna Parameters 01.00 PM 05.00 PM
DAY - 03 (08-12-2021)
12 | Importance of HFSS with other tools 09.00 AM 12.15PM
13 | Lunch Break 12.15 PM 01.00 PM
14 | Antenna Designing Mathematical 01.00 PM 05.00 PM
Calculations
DAY - 04 (09-12-2021)
15 | Antenna Designing Procedures 09.00 AM 12.15 PM
16 | Lunch Break 12.15 PM 01.00 PM
17 | Di-Pole Antenna Design in HFSS 01.00 PM 05.00 PM
DAY - 05 (10-12-2021)
18 | Result Analysis 09.00 AM 12.15PM
19 | Lunch Break 12.15PM 01.00 PM
20 | Some Sample Antenna Designs 01.00 PM 04.15 PM
21 | Certificate Program Exam 04.15 PM 04.45 PM
22 | Vote of Thanks 04.45 PM 05.00 PM




RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPAR” INT OF ELECTRONICS AND COMMUNICATION FNGINEERING

Student Feedback Form

Name of the Student: P&MM Qe A PNA
Roll No PeseLAouw s
Topic : Certificate Program on ""Antenna Design using HFSS" Date: 10-12-2021
S.No Feedback Points 5 4 3 2 1

1 |Is the certification program useful or not ? e

2 |Is the certification program well planned or not? f

3 |Lecture makes objectives clear? v

4 |Lecture speaks clearly and audibly? i

5 |Lecture explains with exaples clearly? e

6 |Is you are doubts clarified or not? e
5-Excellent 4-Good 3-Average 2-Poor 1- No comment

P Siraen
Stud%nt%fgngfure
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING

Student Feedback Form

Name of the Student: PV Slv A
Roll No 188 AG\&\Q_D - .
Topic : Certificate Program on "Antenna Design using HFSS" Date: 10-12-2021
S.No Feedback Points 5 4 3 2 1

1 |Is the certification program useful or not ? Ve

2 |ls the certification program well planned or not? s

3 |Lecture makes objectives clear? o

4 |Lecture speaks clearly and audibly? /5

5 |Lecture explains with exaples clearly? - o

6 |is you are doubts clarified or not? Z
5-Excellent 4-Good 3-Average 2-Poor 1- No comment

0. S\¥ort
Student Signature
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Student Feedback Form
Name of the Student: G\ ot X S oo

Roll No g
G\ U
Topic : Certificate Pr(}ggl‘gm onesAantkrﬁlﬁ%)esign using HFSS"

RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPART}M "NT OF ELECTRONICS AND COMMUNICATION I "GINEERING

Date: 10-12-2021

S.No Feedback Points

[s the certification program useful or not ?

Lecture makes objectives clear?

5

i
[s the certification program well planned or not? T
/

/

Lecture explains with exaples clearly?

\

Is you are doubts clarified or not?

1
2
3
4 |Lecture speaks clearly and audibly?
5
6
-E

5-Excellent 4-Good 3-Average 2-Poor

1- No comment
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING

Student Feedback Form

Name of the Student: “THoTA Gap\
LI F 188l AOUSY
Topic : Certificate Program on '"Antenna Design using HFSS" Date: 10-12-2021
S.No Feedback Points 5 4 3 2 1

1 |Is the certification program useful or not ? e

2 |Is the certification program well planned or not? Ve

3 |Lecture makes objectives clear? e

4 |Lecture speaks clearly and audibly? v

5 |Lecture explains with exaples clearly? v

6 |Is you are doubts clarified or not? v
5-Excellent 4-Good 3-Average  2-Poor |- No comment
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A.Y:2021-2022
Name of the Certificate Program: Antenna Design using HFSS

RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE

DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING
CERTIFICATE PROGRAM FEEDBACK ANALYSIS
Year : IV B.Tech ECE

Date: 10-12-2021

S.No

Roll Number

Name

1

188B1A0401

ABOTHU DIVYA

2

188B1A0402

ADIPUDI NAGA LAKSHMI NIKHITHA

(V%)

188B1A0403

ATHYALA JOYSIRIYA

188B1A0404

AVVARU ANUSHA

188B1A0405

BATTULA RAJANI

188B1A0406

BELLAMKONDA SRI VENKATESWARA

188B1A0407

CHIMAKURTHI NAGA LAKSHMI PRAVALLIKA

188B1A0408

CHALLA SAI LAKSHMI SANTHOSHI

188B1A0410

DACHARLA SUPRAJA

188B1A0411

DESIREDDY SUMATHI

188B1A0412

DIVI SIVANI

188B1A0413

GANGIREDDY DHANA LAKSHMI

188B1A0414

GOLLA JYOSHNA

188B1A0415

JALLI BRIGHTY MANVITHA

188B1A0416

JASHTI LAKSHMI DEV!

188B1A0417

KAMJULA NAGA ANUHYA

__,—-—————————.

188B1A0418

Pt

RISE|
GRO

KANAMARLAPUDI DIVYA w




S.No| Roll Number Name 1 2 4 5
18 188B1A0419 [KAMJULA SUJIATHA 5 5 4 5
19 188B1A0420 |KONKIMUDUSU MADHAVI 3 4 5 5
20 188B1A0421 |KOPPOLU SATHVIKA 3 4 5 5
21 188B1A0422 |KOTHURI KOTI SAI SUPRIYA 5 5 4 5
22 188B1A0424 [KOYISRIPOOJITHA 3 4 5 4
23 188B1A0425 [MAKKENA YASODAMMA 4 5 5 4
24 188B1A0426 |MITTA ANJALI 4 4 5 5
25 188B1A0427 |MOPIDEVI ANUSHA 3 4 5 4
26 188B1A0428 |NALAMALAPU KAVYA 4 4 4 S
27 188B1A0429 |PATAN SHAMA 5 4 5 4
28 188B1A0430 [PATRINAGA BHAVANA 5 5 4 5
29 188B1A0431 |[PERAM SWAPNA 3 4 S5 5
30 188B1A0432 |PINNINTINAVYA 5 5 5 5
31 188B1A0433 |[PITTU SAI BHARGAVI 5 4 4 5
32 188B1A0434 |PULAKANAM AKHILA 5 5 S 4
33 188B1A0435 |SHAIK SHALIMA 4 4 5 5
34 188B1A0436 |SHEIK SALMA 5 5 4 4
35 188B1A0437 |THATIKONDA LAVANYA 5 5 4 5
36 188B1A0438 |UDALA VENKATA LAKSHMI PRIYA ___4‘ 5 5 5
37 188B1A0439 ”{ 4 5 5

R —em——
VANKADARI GAYATRI @%




S.No| Roll Number Name 3 4 6
38 188B1A0440 |[YAKKALA VENKATA NIKHILA 5 5 5
39 188B1A0441 |YELCHURI LAKSHMI PRASANNA 4 5 4
40 188B1A0442 |ATTALURI PAVAN RENUKA CHARI 5 5 4
41 188B1A0443 |BEZAWADA SREEKANTH 5 5 4
42 188B1A0444 |BOLLA GANGADHAR 5 4 5
43 188B1A0445 [ELCHURI VINAY KUMAR 5 4 4
44 188B1A0446 |JAGANNADHAM NAVEEN KUMAR 5 5 5
45 188B1A0447 |KANAMARLAPUDI SATYAVARDHAN 5 5 5
46 188B1A0448 |KARNA PAVAN KUMAR REDDY 5 5 5
47 188B1A0449 |KURAPATI VIDYASAGAR 4 5 5
48 188B1A0450 |MALLAVARAPU VENKATA RAMI REDDY 4 S 4
49 188B1A0451 |MALASANI VENKATA VAMSI KRISHNA 5 4 4
50 188B1A0452 |MEDA HARISH 4 5 4
51 188B1A0453 [P UV NS M JANAKIRAM SHARMA 4 S 5
52 188B1A0454 |RALLAPALLE VEERA ViSHNU S 4 S
53 188B1A0455 |[SHAIK ABDHUL AZEESH 4 5 5
54 188B1A0456 |SHAIK ANIL KUMAR 4 5, 4
55 188B1A0457 |THOTA GNAN VAMSI SAI KRISHNA 5 5 S
56 188B1A0458 |THOTA GOPI1 £ 4 5 4

7
57 188B1A0459 = 5 5 5

VAKA PRAVEEN KUMAR REDIy/ -
\Q o) g%‘l//
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S.No| Roll Number Name 3
58 |188B1A0461  |ALLU LAKSHMI 4
59 |188B1A0462  |[BOLLISETTY JYOTHIRMAY 4
60 |188B1A0463 |CHAKKA ANUHYA

61 |188B1A0464 |CHAKRALA MANIMALA

62 |188B1A0465 |CHEEDELLA DIVYASRI

63 |188B1A0466 |CHOUTA VYSHNAVI

64 |188B1A0467 |DASARI AMRUTHA

65 |188B1A0468  [DUMPA ANJALI

66 |I88BIAD469  |ENIKAPATI ANITHA

67 |188B1A0470  |ENIKAPATI ANUSHA

68 |188B1A0471  |GAJJALA SANDHYA

69 |188B1A0472  |GARLAPATI KAMALA KUMARI

70 {188B1A0473  [GOLI SOWMYA

71 |188B1A0474  |KAMIULA VASANTHA LAKSHMI

72 |188B1A0475  |KARI SAHITHI

73 [188B1A0476  [KOPPARTHI HYMAVATHI

74 |188B1A0477  |KOTA RENUKA

75 |188B1A0478  |[LEBAKA SASI BALA

76 [188B1A0479 |MEDIDA MOUNIKA

77 |188B1A0480  |MOPIDEVI NAGA NANDINI / - 4

o /"‘DI'
@ PRINCIFAL
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G OT INSTITUTION



S.No| Reoll Number Name 1 2 3 6
78 }188B1A0481 MULI BINDU 5 5 4 5
79 [188B1A0482 NARIPEDDI MEGHANA 5 5 4 5
80 |188B1A0484 PATHAN SHYLABANU 5 5 4 5
81 |188B1A0485 PERLA PRAVALLIKA 5 5 5 5
82 |188B1A0486 PINISETTY RAJITHA 4 5 4 5
83 |188B1A0487 SANDIREDDY SOUNDARYA 5 5 4 4
84 |188B1A0488 SHAIK SHARMILA 5 5 5 5
85 |188B1A0489 SOMINENI JYOTHSNA 5 5 4 4
86 (188B1A0490 TANGA SAI RAMYA 4 5 4 5
87 |188B1A0491 TURIMELLA SRAVANI 5 5 5 5
88 |188B1A0492 VEMURI SHAHINA 4 5 4 5
89 |188B1A0493 YALLATURI DEVI SIRISHA 5 S 4 5
90 [188B1A0494 ANCHULA VENKATESWARLU 5 5 4 4
91 |188B1A0495 B BHARATH KUMAR REDDY 5 5 4 4
92 |188B1A0496 BETHAMSETTY VAMSIKRISHNA SAISRINIVAS 4 4 4 5
93 [188B1A0497 BODDU JANARDHAN RAO 5 4 4 5
94 [188B1A0498 BUKKA PRABHU TEJA 4 5 4 5
95 [188B1A0499 BURLA PRANEETH REDDY 5 4 5 5
96 |188B1A04A0 |DAMERLA VAMSI KRISHNA /———55 5 4 5
97 |188B1A04AL DHARMAVARAPU THARUN KUMM A 5 4 4 5
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S.No| Roll Number Name 1 2 3 4 6
98 |188B1A04A2 GADDE RAJESH 4 5 4 5 5
99 |188B1A04A3 KARAMSETTY J CH P VENKATA SAI MANEESH 5 5 5 4 5
100 |188B1A04A4 |KOCHARLA KARTHIK 4 5 4 5 5
101 [188B1A04AS KOLLIPARA PAVAN KALYAN 4 4 4 5 4
102 |188B1A04A6 MANDLA SRINIVASULU 5 4 4 5 4
103 |188B1A04A7 |NALLAGUNDLA VINAY KUMAR 4 5 5 4 5
104 [188B1A04A8 PASUPULETI GOPI KRISHNA 4 5 5 5
105 |188B1A04B0 SEELAM RAMU 4 4 5 4 5
106 (188B1A04B1 SHAIK HEMANTH BABU 5 4 5 5 4
107 |188B1A04B2 TANGUTURI KUMAR 5 4 5 5 4
108 |188B1A04B3 VADITHE SIVA PRASAD NAIK 4 4 4 5 5
109 (188B1A04B4 VAIDALA GIREESH REDDY 5 5 3 4 S
110 |188B1A04BS5 VELICHERLA PRABHAKAR REDDY 4 5 5 5 5
111 |188B1A04B6 VUTUKURI BALASURYA PRADEEP 5 5 5 4 5
112 [188B1A04B8 KESANA AISHWARYA BHAVAN] 4 5 5 4 5
113 |{188B1A04B9 BATTINI VENKATA PRASAD 5 4 5 5 4
114 | 198B5A0401 [APPALA SARVANI 4 5 5 4 5
115 | 198B5A0402 [BANDLA VENKATA NIKHITHA 5 4 5 5 S
116 | 198B5A0403 |PULICHARLA DEEPIKA e o 1] 4 5 5 4 5
117 | 198B5A0404 B 5 5 4 5

VEGURI SWATHI W 5]
PRINCIPA
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S.No| Roll Number Name 1 2 3 4 5 6
118 | 198B5A0405 |ANKIREDDY VAMSI 5 5 4 4 5 5
119 | 198B5A0406 |ARLA CHANDRA SHEKHAR 5 5 5 5 5 5
120 | 198B5A0407 [GORREMUCHHU SANDEEP 4 5 5 4 5 5
121 |198B5A0408 GUNIMINI SAI 5 5 5 4 5 5
122 |198B5A0409 KALLURI SARATH 4 4 5 4 5 5
123 [198B5A0410 PULUGU DEVENDAR REDDY 5 5 5 5 4 4
124 |198B5A0411 PUNNEPALLI RAKESH 5 5 5 5 5 5
125 |198B5A0412 SHAIK AZIS 5 4 4 5 5 5
126 [198B5A0413 NARAYANAM SREE VASU 4 5 5 5 4 5

479 | 475 | 463 | 475 | 4.88 4.63

95.71| 95.00 [ 92.50]95.00| 97.50 | 92.50
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
(Approved by AICTE, New Delhi & Affiliated to INTUK, Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate program Feedback Analysis

Topic . Certification program on” Antenna Design using HFSS”

Resource Person : Dr.P.Surendra Kumar,

Associate Professor, Bapatla Engineering College, Bapatla.
: 06-12-2021 to 10-12-2021
: MPMC Lab

: TV Year students

Dates
Venue

Targeted Students

No. of students No. of students s
S.No Participated given feedback Eeedbackls
| 126 126 100%

¢ OS@to r



#%%. RISE KRISHNA SAT GANDHI GROUP OF INSTITUTIONS
2N (Approved by AICTE,New Delhi & Affiliated to INTUK K akinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate Program on Antenna Design using HFSS
Model Question Paper

Branch/Sem: IV ECE/I SEM
Name of the Student: ROLL Number:

1. HFSS can simulate the effect of on the performance of a phased array
antenna.

a) Beamforming []
b) Polarization

c) Frequency

d) All of the above

2. The "Smith chart" is a graphical tool used in HFSS for ; []
a) Analyzing transmission lines

b) Visualizing impedance matching

¢) Studying polarization

d) All of the above

3. In HFSS, the ""boundary" conditions are used to specify the behavior of electromagnetic
fields at the of the simulation domain. L]

a) Interior

b) Exterior

c) Center

d) Edges

4. HFSS can simulate the effect of on the performance of an antenna| |
a) External objects

b) Surrounding structures
c) Nearby antennas
d) All of the above

5. The term “impedance matching” in antenna design refers to - [1
a) Matching the antenna's impedance to the transmission line

b) Matching the antenna's impedance to free space

¢) Adjusting the frequency of operation

d)Bothaandb

6. HESS can analyze antennas for different : [1]
a) Polarizations

b) Frequencies

¢) Operating conditions

d) All of the above



#5% RISE KRISHNA SAT GANDHI GROUP OF INSTITUTIONS
SfpAURES (Approved by AICTE,New Delhi & Affiliated to INTUK Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

7. HFSS is a software tool used for simulations. [
a) Mechanical

b) Electromagnetic

c) Thermal

d) Fluid dynamics

8. The acronym HFSS stands for . [1]
a) High-Frequency Signal Simulation

b) High-Fidelity Structure Solver

c) High-Frequency Structure Simulator

d) High-Field Simulation Software

9. HFSS is commonly used for designing and simulating " []
a) Antennas

b) Bridges

¢) Buildings

d) Automobiles

10. In HFSS, the unit of frequency is typically expressed in : [1]
a) Hertz (Hz)

b) Watts (W)

c) Newtons (N)

d) Volts (V)

11. The most common type of antenna simulated using HFSS is the

antenna. []
a) Yagi-Uda

b) Patch

c) Dipole

d) Log-periodic

12. HFSS uses the method for solving Maxwell's equations. [1
a) Finite Difference Time Domain (FDTD)

b) Method of Moments (MoM)

¢) Finite Element Method (FEM)

d) Finite Integration Technique (FIT)

13. What does the acronym MoM stand for in the context of electromagnetic simulations?
[]

a) Method of Moments

b) Moments of Magnitude

¢) Moments of Motion

d) Method of Magnetics

RISE KR
GROLP 0¥



“: RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
3 (Approved by AICTE,New Delhi & Affiliated to INTUK Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

14. HFSS can analyze antennas operating in different frequency domains, including
= LR T [1]
a) DC (Direct Current)

b) RF (Radio Frequency)

c) Optical

d) All of the above

15. The term "meshing" in HFSS refers to the process of dividing the geometry into

o 2, [1]
a) Materials

b) Domains
c¢) Mesh elements
d) Layers

16. HFSS can simulate both and antennas. [ ]
a) Active, Passive

b) Linear, Non-linear

c) Planar, Non-planar

d) Omni-directional, Directional

17. The S-parameter that represents the power reflected back from an antenna is

e 1
a) S11

b) S21
c)S12
d) S22

18. The characteristic impedance of a transmission line is represented by the
parameter. [ 1]

a)Z11

b) 221

c)Z12

d) 722

19. HFSS can simulate the radiation pattern of an antenna, which describes its___
a) Frequency response L1
b) Gain

c) Spatial distribution of radiation

d) Polarization
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20. The "far-field" region of an antenna is also known as the region.|[ |
a) Reactive
b) Near-field
¢) Intermediate

d) Radiative
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ANSWERS

1. [a] Beamforming

2. [b] Visualizing impedance matching
3. [d] Edges

4. [d] All of the above

5.[d] Both aand b

6. [d] All of the above

7. [b] Electromagnetic

8. [c] High-Frequency Structure Simulator
9. [a] Antennas

10. [a] Hertz (Hz)

11. [b] Patch

12. [c] Finite Element Method (FEM)
13. [a] Method of Moments

14. [d] All of the above

15. [c] Mesh elements

16. [c] Planar, Non-planar

17.[a] S11

18.[a] Z11

19. [c] Spatial distribution of radiation
20. [d] Radiative
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Certificate Program on Antenna Design using HFSS
Model Question Paper

Branch/Sem: IV ECE/l SEM

Name of the Student: M egla. - ‘\—lo-a.l%h ROLL Number: | 8631 i ANP

1. HFSS can simulate the effect of on the performance of a phased array
antenna.

a) Beamforming AL
b) Polarization -/

c) Frequency
d) All of the above

2. The "Smith chart" is a graphical tool used in HFSS for ‘ [ B

a) Analyzing transmission lines ./
b) Visualizing impedance matching

¢) Studying polarization

d) All of the above

3. In HFSS, the "boundary'' conditions are used to specify the behavior of electromagnetic
fields at the of the simulation domain. D

a) Interior =

b) Exterior

c) Center

d) Edges

4. HFSS can simulate the effect of on the performance of an antennaf’] -
a) External objects :

b) Surrounding structures

¢) Nearby antennas

d) All of the above

5. The term “impedance matching” in antenna design refers to : i
a) Matching the antenna's impedance to the transmission line

b) Matching the antenna’s impedance to free space

¢) Adjusting the frequency of operation

d)Bothaand b

6. HFSS can analyze antennas for different : D
a) Polarizations /

b) Frequencies
¢) Operating conditions
d) All of the above

U 1{) i :
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7. HESS is a software tool used for simulations. 9/
a) Mechanical

b) Electromagnetic

c) Thermal

d) Fluid dynamics

8. The acronym HFSS stands for ’ [a
a) High-Frequency Signal Simulation /
b) High-Fidelity Structure Solver

c) High-Frequency Structure Simulator

d) High-Field Simulation Software

9. HFSS is commonly used for designing and simulating . M/
a) Antennas

b) Bridges

c) Buildings

d) Automobiles

10. In HESS, the unit of frequency is typically expressed in
a) Hertz (Hz)

b) Watts (W)

c) Newtons (N)

d) Volts (V)

\312

11. The most common type of antenna simulated using HFSS is the

antenna. e
a) Yagi-Uda ;Y
b) Patch

¢) Dipole
d) Log-periodic

12. HFSS uses the method for solving Maxwell's equations. p/
a) Finite Difference Time Domain (FDTD)

b) Method of Moments (MoM)

¢) Finite Element Method (FEM)

d) Finite Integration Technique (FIT)

13. What does the acronym MoM stand for in the context of electromagnetic simulations?

A
a) Method of Moments /
b) Moments of Magnitude
¢) Moments of Motion

d) Method of Magnetics
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14. HFSS can analyze antennas operating in different frequency domains, including n/-
[

a) DC (Direct Current)
b) RF (Radio Frequency)
c) Optical

d) All of the above

15. The term "meshing'' in HFSS refers to the process of dividing the geometry into

a) Materials ‘9/

b) Domains

¢) Mesh elements

d) Layers

16. HFSS can simulate both and antennas. [l

a) Active, Passive /

b) Linear, Non-linear
¢) Planar, Non-planar
d) Omni-directional, Directional

17. The S-parameter that represents the power reflected back from an antenna is

_ [Al
a) S11 L
b) S21
¢)Si2
d) S22

18. The characteristic impedance of a transmission line is represented by the
parameter. 13

a)Z11
b) 221 )J
¢) Z12
d) 722

19. HFSS can simulate the radiation pattern of an antenna, which describes its____
a) Frequency response 7A3|
b) Gain y
¢) Spatial distribution of radiation

d) Polarization
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20. The "far-field" region of an antenna is also known as the region.[]
a) Reactive
b) Near-field
¢) Intermediate

d) Radiative
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Certificate Program on Antenna Design using HFSS ¢
Model Question Paper

Branch/Sem: IV ECE/l SEM
Name of the Student: Thoti Konda (Qvaﬂj Q ROLL Number: {$ 8
1. HFSS can simulate the effect of on the performance of a phased array
antenna.
a) Beamforming
b) Polarization ﬁr
c) Frequency
d) All of the above
2. The "Smith chart' is a graphical tool used in HFSS for - Wl
a) Analyzing transmission lines /
b) Visualizing impedance matching

¢) Studying polarization
d) All of the above

3. In HFSS, the "boundary" conditions are used to specify the behavior of electromagnetic_
ficlds at the of the simulation domain. y}

a) Interior

b) Exterior

c) Center

d) Edges

4, HFSS can simulate the effect of on the performance of an antennfx}ﬂ]/'
a) External objects

b) Surrounding structures

¢) Nearby antennas

d) All of the above

5. The term “impedance matching” in antenna design refers to : gf
a) Matching the antenna's impedance to the transmission line

b) Matching the antenna's impedance to free space

c) Adjusting the frequency of operation

d)Bothaand b

6. HFSS can analyze antennas for different : y}/
a) Polarizations

b) Frequencies

¢) Operating conditions

d) All of the above
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7. HFSS is a software tool used for simulations. [l

a) Mechanical 7”

b) Electromagnetic

c) Thermal

d) Fluid dynamics

8. The acronym HFSS stands for i Ld/

a) High-Frequency Signal Simulation
b) High-Fidelity Structure Solver

c) High-Frequency Structure Simulator
d) High-Field Simulation Software

9. HFSS is commonly used for designing and simulating g 9}/
a) Antennas

b) Bridges
¢) Buildings
d) Automobiles

10. In HFSS, the unit of frequency is typically expressed in g g/
a) Hertz (Hz)

b) Watts (W)

c) Newtons (N)

d) Volts (V)

11. The most common type of antenna simulated using HFSS is the .
antenna. )

a) Yagi-Uda /
b) Patch

c) Dipole
d) Log-periodic

12. HFSS uses the method for solving Maxwell's equations. d

2) Finite Difference Time Domain (FDTD) /
b) Method of Moments (MoM)

¢) Finite Element Method (FEM)

d) Finite Integration Technique (FIT)

13. What does the acronym MoM stand for in the context of electromagnetic simulations?

Al
a) Method of Moments

b) Moments of Magnitude
¢) Moments of Motion
d) Method of Magnetics
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14. HFSS can analyze antennas operating in different frequency domains, including

Bt i 41
a) DC (Direct Current)
b) RF (Radio Frequency) /
¢) Optical
d) All of the above
15. The term "meshing'' in HFSS refers to the process of dividing the geometry into

: 1d
a) Materials
b) Domains /
¢) Mesh elements
d) Layers
16. HFSS can simulate both and antennas. M
a) Active, Passive

b) Linear, Non-linear
¢) Planar, Non-planar
d) Omni-directional, Directional

17. The S-parameter that represents the power reflected back from an antenna is
e

a) Sl @

b) S21

c) S12

d) S22

18. The characteristic impcdance of a transmission line is represented by the

parameter. [
a)Z11 ‘9]/-

b) 221
c)Z12
d)Z22

19. HFSS can simulate the radiation pattern of an antenna, which describes its___

a) Frequency response \[C]/

b) Gain
¢) Spatial distribution of radiation

d) Polarization

e
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20. The "far-field" region of an antenna is also known as the region. ]
a) Reactive /
b) Near-field
¢) Intermediate

d) Radiative

R

croue GF 1ISTH
\il"\LLURb:: !

-

-



e RISE KRISHNA SAT GANDHI GROUP OF INSTITUTIONS
pEE S (Approved by AICTE, New Delhi & Affiliated to JINTUK, Kakinada)

NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate Program on Antenna Design using HFSS Marks

AY :2021-2022 Year: IV
S. No Reg. No Name of the Candidate Marks
1 188B1A0401 | ABOTHU DIVYA 18
2 188B1A0402 | ADIPUDI NAGA LAKSHMI NIKHITHA 18
3 188B1A0403 | ATHYALA JOYSIRIYA 17
4 188B1A0404 | AVVARU ANUSHA 19
5 188B1A0405 | BATTULA RAJANI 20
6 188B1A0406 | BELLAMKONDA SRI VENKATESWARA 20
7 188B1A0407 | CHIMAKURTHI NAGA LAKSHMI PRAVALLIKA 16
8 188B1A0408 | CHALLA SAI LAKSHMI SANTHOSHI 19
9 188B1A0410 | DACHARLA SUPRAJA 16
10 188B1A0411 | DESIREDDY SUMATHI 20
11 188B1A0412 | DIVI SIVANI 19
12 188B1A0413 | GANGIREDDY DHANA LAKSHMI 16
13 188B1A0414 | GOLLA JYOSHNA 19
14 188B1A0415 | JALLI BRIGHTY MANVITHA 19
15 188B1A0416 | JASHTI LAKSHMI DEVI 20
16 188B1A0417 | KAMJULA NAGA ANUHYA 17
17 188B1A0418 | KANAMARLAPUDI DIVYA JYOTHI 18
18 188B1A0419 | KAMJULA SUJATHA 17
19 188B1A0420 | KONKIMUDUSU MADHAVI 18
20 188B1A0421 | KOPPOLU SATHVIKA 19
21 188B1A0422 | KOTHURI KOTI SAI SUPRIYA 18
22 188B1A0424 | KOYI SRI POOJITHA . 18
3 188B1A0425 | MAKKENA YASODAMMA 18
24 188B1A0426 | MITTA ANJALI 18
25 18881A0427 | MOPIDEVI ANUSHA 18
26 | 188B1A0428 | NALAMALAPU KAVYA : 18
7x) 188B1A0429 | PATAN SHAMA 13
28 188B1A0430 | PATRI NAGA BHAVANA 19
29 188B1A0431 | PERAM SWAPNA 18
30 188B1A0432 | PINNINTI NAVYA 19
31 188B1A0433 | PITTU SAI BHARGAVI 17
32 188B1A0434 | PULAKANAM AKHILA 18
33 188B1A0435 | SHAIK SHALIMA L I8
34 188B1A0436 | SHEIK SALMA
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S. No Reg. No Name of the Candidate Marks
35 188B1A0437 | THATIKONDA LAVANYA 19
36 188B1A0438 | UDALA VENKATA LAKSHMI PRIYA 18
37 188B1A0439 | VANKADARI GAYATRI 19
38 188B1A0440 | YAKKALA VENKATA NIKHILA 17
39 188B1A0441 | YELCHURI LAKSHMI PRASANNA 19
40 188B1A0442 | ATTALURI PAVAN RENUKA CHARI 16
41 188B1A0443 | BEZAWADA SREEKANTH 16
42 188B1A0444 | BOLLA GANGADHAR 16
43 188B1A0445 | ELCHURI VINAY KUMAR 17
44 188B1A0446 | JAGANNADHAM NAVEEN KUMAR 15
45 188B1A0447 | KANAMARLAPUDI SATYAVARDHAN 18
46 188B1A0448 | KARNA PAVAN KUMAR REDDY 17

47 188B1A0449 | KURAPATI VIDYASAGAR 19
48 188B1A0450 | MALLAVARAPU VENKATA RAMI REDDY 20
49 188B1A0451 | MALASANI VENKATA VAMSI KRISHNA 20
50 188B1A0452 | MEDA HARISH 17
51 188B1A0453 | PUV N S M JANAKIRAM SHARMA 19
52 188B1A0454 | RALLAPALLE VEERA VISHNU 18
53 188B1A0455 | SHAIK ABDHUL AZEESH 19
54 188B1A0456 | SHAIK ANIL KUMAR 19
55 188B1A0457 | THOTA GNAN VAMSI SAI KRISHNA 19
56 188B1A0458 | THOTA GOPI 19
57 188B1A0459 | VAKA PRAVEEN KUMAR REDDY 19
58 188B1A0461 | ALLU LAKSHMI 19
59 188B1A0462 | BOLLISETTY JYOTHIRMAY 18
60 188B1A0463 | CHAKKA ANUHYA 18
61 188B1A0464 | CHAKRALA MANIMALA 17
62 188B1A0465 | CHEEDELLA DIVYASRI 19
63 188B1A0466 | CHOUTA VYSHNAVI 17
64 188B1A0467 | DASARI AMRUTHA 16
65 188B1A0468 | DUMPA ANJALI 16
66 188B1A0469 | ENIKAPATI ANITHA 15
67 188B1A0470 | ENIKAPATI ANUSHA 18
68 188B1A0471 | GAJJALA SANDHYA 17
69 188B1A0472 | GARLAPATI KAMALA KUMARI 19
70 188B1A0473 | GOLI SOWMYA 19
71 188B1A0474 | KAMIJULA VASANTHA LAKSHMI / N B 19
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72 188B1A0475 | KARI SAHITHI 20
73 188B1A0476 | KOPPARTHI HYMAVATHI 15
74 188B1A0477 | KOTA RENUKA 16
75 188B1A0478 | LEBAKA SASI BALA 15
76 188B1A0479 | MEDIDA MOUNIKA 15
77 188B1A0480 | MOPIDEVI NAGA NANDINI 18

L 188B1A0481 | MULI BINDU 17
79 188B1A0482 | NARIPEDDI MEGHANA 18
80 188B1A0484 | PATHAN SHYLABANU 19
81 188B1A0485 | PERLA PRAVALLIKA 18
82 188B1A0486 | PINISETTY RAJITHA 18
83 188B1A0487 | SANDIREDDY SOUNDARYA 17
84 188B1A0488 | SHAIK SHARMILA 19
85 188B1A0489 | SOMINENI JYOTHSNA 20
86 188B1A0490 | TANGA SAI RAMYA 20 |
87 | 188B1A0491 | TURIMELLA SRAVANI 16
88 188B1A0492 | VEMURI SHAHINA 19
89 188B1A0493 | YALLATURI DEVI SIRISHA 16
90 188B1A0494 | ANCHULA VENKATESWARLU 20
91 188B1A0495 | B BHARATH KUMAR REDDY 16
92 188B1A0496 | BETHAMSETTY VAMSIKRISHNA SAISRINIVAS 19

3 188B1A0497 | BODDU JANARDHAN RAO 18
94 188B1A0498 | BUKKA PRABHU TEJA 19
95 188B1A0499 | BURLA PRANEETH REDDY 18
96 188B1A04A0 | DAMERLA VAMSI KRISHNA 17
97 188B1A04A1 | DHARMAVARAPU THARUN KUMAR 17
98 188B1A04A2 | GADDE RAJESH 17
99 188B1A04A3 | KARAMSETTY J CH P VENKATA SAI MANEESH 19
100 188B1A04A4 | KOCHARLA KARTHIK 16
101 188B1A04A5 | KOLLIPARA PAVAN KALYAN 19
102 188B1A04A6 | MANDLA SRINIVASULU 19
103 188B1A04A7 | NALLAGUNDLA VINAY KUMAR 18
104 188B1A04A8 | PASUPULETI GOPI KRISHNA 17
105 188B1A04B0 | SEELAM RAMU 18
106 188B1A04B1 | SHAIK HEMANTH BABU 19
107 | 188B1A04B2 | TANGUTURI KUMAR = - . 2
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114 198B5A0401 | APPALA SARVANI 19
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Certification Program Report on

Antenna Design using HFSS”

Date: 06" to 10" December 2021

Introduction:

The Antenna Design using HFSS Certification Program, held from 06" to 10" December 2021, was organized
under the visionary leadership of the Head of the Department, Mr. S.V. Ravi Kumar. The program aimed to
provide participants with an in-depth understanding of antenna design principles and hands-on experience with
the High-Frequency Structure Simulator (HFSS) sofiware. Dr. K.V. Subrahmanyam, our esteemed Principal,
and Dr. P. Surendra Kumar, a distinguished resource person, played pivotal roles in ensuring the success of this

educational endeavor.

Syllabus covered:

1. Introduction to Antennas: The program commenced under the guidance of Dr. P. Surendra Kumar, whose
leadership set the tone for an exploration of fundamental antenna concepts. Participants delved into the
historical development of antennas, their role in communication systems, and various antenna
types.Antennas are fundamental components in the field of electromagnetic communication, serving as the
bridge between electronic devices and the surrounding electromagnetic environment. These devices play a
pivotal role in transmitting and receiving electromagnetic waves, enabling wireless communication across a
myriad of applications such as radio and television broadcasting, mobile communication, radar systems,
satellite communication, and more.

Historical Evolution: The history of antennas traces back to the late 19th century, coinciding with the
groundbreaking work of pioneers such as Heinrich Hertz and Guglielmo Marconi. Hertz's experiments with
radio waves and Marconi's subsequent development of practical wireless communication marked the advent

of antenna technology. Since then, antennas have evolved significantly, driven by technological

odetn commupieagpn systems.
electrieal signals into electromagnetic

waves for transmission or vice versa for reception. This péocess involves the manipulation of electric and

advancements and the ever-expanding demands of m

Basic Concepts:At its core, an antenna is a transd
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magnetic fields to generate a propagating electromagnetic wave. Key parameters such as frequency, gain,
polarization, and radiation pattern define the performance characteristics of an antenna.

a. Types of Antennas: Antennas come in various forms, each tailored to specific applications and
operating principles. Common types include dipole antennas. monopole antennas, patch
antennas, yagi-uda antennas, and parabolic antennas. The selection of an antenna type depends
on factors such as frequency range, directional requirements, and the overall communication
system's design goals.

b. Role in Communication Systems: In communication systems, antennas serve as the interface
between electronic circuits and the surrounding electromagnetic field. In transmission, an
electrical signal is applied to the antenna, converting it into an electromagnetic wave that
propagates through space to reach the intended receiver. In reception, the antenna captures
incoming electromagnetic waves, converting them back into electrical signals for further
processing.

c. Parameters and Characteristics: Understanding and optimizing antenna parameters are
essential for efficient communication system design. Parameters such as impedance, bandwidth,
radiation patlern, and elficiency influence an antenna's performance. Engineers and designers
carefully consider these factors to achieve desired outcomes in terms of signal coverage, range,
and reliability.

d. Technological Advancements: Advancements in materials, design techniques, and
computational tools have significantly contributed to the evolution of antenna technology.
Computer-aided design (CAD) software, electromagnetic simulation tools, and advanced
manufacturing processes have empowered engineers to create antennas with enhanced
performance and reduced size, pushing the boundaries of what is achievable in modern
communication systems.

e. Future Trends: The evolution of antennas continues as we enter an era of pervasive
connectivity and the Internet of Things (loT). Miniaturization, multi-functionality, and
adaptability are becoming increasingly important. Antennas are expected to play a crucial role in
the development of 5G networks, smart cities, and emerging technologies, further shaping the
landscape of wireless communication.

2. Antenna Architecture: Antenna architecture encompasses the structural design and configuration of

antennas, defining their physical layout and arrangement of elements to achieve specific performance

» antenna's characteristics,

: n, we delve into various
antenna architectures, their applications, and the consid®&tfons that gusde their design.
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Dipole Antennas: Dipole antennas are one of the simplest and most widely used antenna
architectures. They consist of a conductive element, typically a straight wire or pair of wires,
with a voltage source applied across its ends. Dipole antennas radiate energy in a symmetric
pattern and are commonly used in radio and television broadcasting due to their omnidirectional

characteristics.

",  Electromagnetic Wave

+ " %
AV ——— —
= Antenna Rod

Radio Receiver
Monopole Antennas: A monopole antenna is a single, straight conductor mounted over a

ground plane. It is a half-wave dipole with one-half of the dipole element replaced by a ground
plane. Monopole antennas are extensively used in mobile communication devices, where their
compact size and omnidirectional radiation pattern make them suitable for various applications.
Patch Antennas: Patch antennas, also known as microstrip antennas, consist of a flat, metallic
patch mounted above a ground plane. They find widespread use in communication systems due
to their low profile, ease of integration, and suitability for planar and conformal applications.
Patch antennas are commonly employed in wireless communication systems, RFID, and satellite
communication.

Yagi-Uda Antennas: Yagi-Uda antennas are directional antennas consisting of multiple parallel
elements, including one driven element, a reflector, and one or more directors. This architecture
provides high gain and directivity, making Yagi-Uda antennas suitable for point-to-point
communication, such as in television reception and amateur radio.

Parabolic Antennas: Parabolic antennas utilize a parabolic reflector to focus incoming or
outgoing electromagnetic waves. The feed antenna, often located at the reflector's focal point,
provides a highly directional beam. Parabolic antennas are widely used in satellite

communication, radar systems, and point-to-point microwave links, where high gain and narrow

openi t allows for a gradual transition
/ct;;ized by their wide bandwidth

beamwidth are critical.

Horn Antennas: Horn antennas feature a fl

between the transmission line and free space¥



and moderate gain. Horn antennas are employed in radar systems, satellite communication, and
microwave applications, where a balanced compromise between gain and bandwidth is required.
Log-Periodic Antennas: Log-periodic antennas consist of multiple dipole elements arranged in
a geometric pattern that repeats logarithmically. This architecture provides consistent
performance over a broad frequency range, making log-periodic antennas suitable for
applications requiring wideband coverage, such as in television broadcasting and

communication systems.

3. Considerations in Antenna Architecture:

a.

Frequency Range: The chosen architecture should be suitable for the frequency range of
interest.

Gain and Directivity: Different architectures offer varying levels of gain and directivity,
influencing the coverage and reach of the antenna.

Size and Form Factor; The physical size and form factor of antenna architecture are critical
considerations, especially in space-constrained environments.

Polarization: The desired polarization (e.g., vertical, horizontal) for communication needs
guides the selection of antenna architecture.

Environmental Factors: Considerations such as wind loading, temperature, and environmental

conditions impact the choice of antenna architecture.

As technology continues to advance, antenna architectures evolve to meet the demands of emerging

applications. The selection of the most suitable architecture involves a careful balance of

performance requirements, environmental considerations, and the specific needs of the

communication system in which the antenna is deployed.

4. Introduction to HFSS:

HFSS, or High-Frequency Structure Simulator, is powerful and versatile electromagnetic simulation

software developed by Ansys, Inc. It is widely used in the field of radio frequency (RF), microwave,

and high-speed digital design for simulating and analyzing electromagnetic fields. HFSS provides

engineers and designers with a comprehensive platform to model, simulate, and optimize complex

electromagnetic systems, including antennas, RF/microwave components, and integrated circuits.

5. Key Features and Capabilities:

a.

Full-wave Electromagnetic Simulation: HFSS employs a full-wave simulation approach,

solving Maxwell's equations to accurately model the ctromagnetic fields in

complex structures. This capability allows for/a d tealistic representation of the

physical phenomena involved in the design of hi quency geffiponents.
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b. Broad Frequency Range: One of HFSS's strengths lies in its ability to handle a broad
frequency range, spanning from radio frequencies (RF) to microwave and millimeter-wave
frequencies. This makes it suitable for the design and analysis of a wide range of devices,
including antennas, filters, transmission lines, and resonators.

c. Parametric Analysis and Optimization: Engineers can perform parametric analysis and
optimization studies using HFSS. This functionality enables the exploration of design variations
and the optimization of parameters to achieve specific performance goals. It is particularly
useful for tuning antenna designs, matching network optimization, and fine-tuning
RF/microwave circuits.

d. Integration with CAD: HFSS seamlessly integrates with computer-aided design (CAD) tools,
allowing users to import complex 3D geometries and structures. This integration streamlines the
design workflow, making it easier for engineers to create accurate models and simulate realistic
scenarios.

e. Antenna Design and Analysis: HFSS is widely recognized for its capabilities in antenna design
and analysis. Engineers can simulate various types of antennas, including wire antennas, patch
antennas, and reflector antennas, among others. The software provides insights into parameters
such as radiation patterns, gain, impedance matching, and efficiency.

f. High-Frequency Component Simulation: HFSS is instrumental in the simulation of high-
frequency components such as filters, couplers, and resonators. Engineers can analyze the
performance of these components in different frequency bands, taking into account the effects of
electromagnetic coupling, signal integrity, and impedance matching.

g. Finite Element Method (FEM) Solver: The software employs the finite element method
(FEM) as its underlying numerical technique for solving Maxwell's equations. This method
enables accurate modeling of complex geometries and material properties, making HFSS
suitable for a wide range of applications in electromagnetics.

h. Transient and Frequency-Domain Analysis: HFSS supports transient and frequency-domain
analyses, allowing engineers to study the time-dependent behavior of electromagnetic fields and
analyze frequency responses. This versatility is beneficial in understanding dynamic behaviors
and optimizing designs for various operational conditions.

6. Applications of HFSS:

a. Wireless Communication Systems: HFSS is wi n and optimization of

}d,evices, base stations, and

antennas for wireless communication system

satellite communication.
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b. RF and Microwave Circuits: Engineers leverage HFSS to simulate and optimize RF and
microwave circuits, such as filters, amplifiers, and matching networks, ensuring optimal
performance and reliability.

c. Radar Systems: HFSS plays a crucial role in the design and analysis of radar systems,
including the antennas and components used in radar transmitters and receivers

d. Integrated Circuits (ICs): For high-speed digital design, HFSS aids in the simulation of signal
integrity, crosstalk, and electromagnetic interference in integrated circuits, ensuring robust
performance.

e. Medical Devices: In the medical field, HFSS is applied to model and analyze electromagnetic
interactions in devices such as MRI coils and biomedical sensors.HFSS is a comprehensive
electromagnetic simulation tool that empowers engineers to design and optimize high-frequency
components with confidence and precision. Its versatile features and broad application spectrum
make it an indispensable tool in industries ranging from telecommunications to aerospace and
heyond.

7. Antenna Parameters: Antennas are essential components in the field of wireless communication,
serving as the interface between electronic devices and the surrounding electromagnetic environment.
The performance of an antenna is characterized by various parameters that define its behavior and
effectiveness in transmitting or receiving electromagnetic waves. Understanding these parameters is
crucial for antenna design, optimization, and integration into communication systems. Here, we explore
key antenna parameters and their significance:

a. Radiation Pattern:

Definition: The radiation pattern of an antenna describes the distribution of radiated
electromagnetic energy in space.

Significance: It provides insights into how an antenna focuses or spreads its energy in different
directions. Common patterns include omnidirectional, directional, and sectorial, influencing
coverage and signal strength.

b. Gain:

Definition: Antenna gain measures the ability of an antenna to direct or concentrate radiated
power in a specific direction.
Significance: A higher gain indicates increased directional focus, enabling longer

communication range or improved signal strength in a partic tion. However, gain is

often a trade-off with beam width and coverage.
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Directivity:

Definition: Directivity represents the concentration of radiated power in a particular direction,
often compared to an isotropic radiator (perfectly omnidirectional).

Significance: High directivity indicates a more focused radiation pattern, contributing to
increased gain in the desired direction.

Beam width:

Definition: Beam width is the angular width of the main lobe in the radiation pattern, measured
between points where the power is half the maximum.

Significance: Narrow beam width enhances directionality but may limit coverage. Broad beam
width is beneficial for omnidirectional coverage.

Polarization:

Definition: Polarization refers to the orientation of the electric field in the electromagnetic wave
radiated by the antenna.

Significance: Proper polarization alignment between transmitting and receiving antennas is
essential for efficient signal coupling. Common polarizations include vertical, horizontal, and
circular.

Impedance:

Definition: Antenna impedance represents the opposition to the flow of alternating current in
the antenna.

Significance: Matching antenna impedance with the transmission line or system impedance is
critical for minimizing signal reflections and maximizing power transfer

Bandwidth:

Definition: Bandwidth refers to the range of frequencies over which the antenna can operate
effectively, often defined by the frequency range where the gain falls within a specified
threshold.

Significance: A broader bandwidth allows the antenna to support a wider range of frequencies,
making it versatile in diverse communication environments.

Efficiency:

Definition: Efficiency quantifies how effectively the antenna converts input power into radiated
electromagnetic waves.

Significance: High efficiency ensures that a significant porti contributes to

useful radiation, minimizing power losses.
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VSWR (Voltage Standing Wave Ratio):

Definition: VSWR measures the ratio of the maximum voltage to the minimum voltage in a
standing wave pattern along the transmission line.

Significance: A low VSWR indicates good impedance matching and minimal signal reflection,
optimizing power transfer.

Resonant Frequency:

Definition: Resonant frequency is the frequency at which an antenna exhibits maximum
efficiency and performance.

Significance: Operating an antenna at its resonant frequency enhances its effectiveness and
ensures optimal performance in a specific frequency band.

Front-to-Back Ratio:

Definition: The front-to-back ratio measures the relative strength of the radiation pattern in the
forward direction compared to the backward direction.

Significance: A higher front-to-back ratio is desirable for directional antennas, minimizing

interference from signals arriving from the rear.

8. Importance of HFSS with other Tools:

10.

HFSS, as a high-fidelity electromagnetic simulation tool, plays a pivotal role in the design and analysis

of antennas, RE/microwave components, and other high-frequency structures. While HFSS is a

powerful standalone tool, its integration with other simulation and design tools enhances the overall

engineering workflow, providing a more comprehensive approach to solving complex electromagnetic

problems. Here's an exploration of the importance of HFSS in conjunction with other tools:

Comprehensive Simulation Capabilities:

a.

HFSS Strengths: HESS excels in full-wave electromagnetic simulations, accurately capturing
complex electromagnetic phenomena.

Complementary Tools: Coupling HFSS with tools for structural, thermal, or fluid dynamics
simulations allows for comprehensive multi-physics analysis, cnsuring a morc realistic

representation of real-world scenarios.

Antenna Designing Mathematical Calculations: Dr. P. Surendra Kumar led participants through the

mathematical foundations of antenna design, including formulas for impedance matching, gain

calculations, and directivity. Real-world applications and case studies illustrated the practical

significance of mathematical calculations in the design process.

/

SO ‘L

- { GANDY
RISE KPR G
GR!

\



11. Antenna Designing Procedures:

Antenna design with HFSS involves leveraging the software's capabilities for electromagnetic

simulation and optimization. Here's a step-by-step procedure for designing an antenna using HFSS:

a.

Define Design Requirements:

Clearly specify the purpose of the antenna (e.g., communication, radar, satellite).Identify key
specifications such as frequency range, gain, radiation pattern, and polarization.

Research and Choose Antenna Type:

Explore different antenna types suitable for the application. Use HFSS's knowledge base and
documentation to understand the strengths and limitations of various antenna types. Choose an
antenna type based on the research and requirements.

HFSS Project Setup:

Launch HFSS and set up a new project.Define project unit, frequency range, and other
simulation settings.

Geometry and Dimensions:

Create the 3D geometry of the antenna using HFSS's modeling tools. Input the calculated
dimensions based on the chosen antenna type and operating frequency.

Excitation and Boundary Conditions:

Define the feeding mechanism (e.g., port, waveguide) using HFSS's excitation features.Apply
appropriate boundary conditions to simulate the antenna's interaction with its surroundings.
Matcrial Assignment:

Assign material properties to the antenna structure using HFSS's material library.Choose
materials based on their electromagnetic characteristics and environmental considerations.
Meshing:

Generate a mesh for the antenna geometry using HFSS's meshing tools. Adjust mesh parameters
to ensure accuracy and efficiency in the simulation.

Simulation:

Run a simulation to analyze the antenna's electromagnetic behavior. Examine key parameters
such as S-parameters, radiation pattern, gain, and impedance matching.

Optimization:

Utilize HFSS's optimization tools to improve antenna performance. Perform parametric sweeps
or use optimization algorithms to adjust antenna parameters for optimal results.[teratively

simulate and optimize until the desired performance is

1's
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Post-Processing and Visualization:

Analyze simulation results using HFSS's post-processing tools. Visualize radiation patterns, far-
field plots, and other relevant data. Evaluate performance metrics and compare with design
requirements.

Fabrication and Prototyping:

Use the optimized design parameters to fabricate a physical prototype. Verify dimensions and
configurations against the simulation results.

Validation and Testing:

Set up a testing environment consistent with real-world conditions. Measure key parameters
using testing equipment such as network analyzers and spectrum analyzers.Validate the

prototype's performance against simulation results.

. Fine-Tuning and Adjustment:

If necessary, make adjustments to the antenna based on testing results.Iterate between
simulation, fabrication, and testing to refine the design.

Documentation:

Document the final antenna design, including specifications, simulation results, and testing
outcomes. Create a comprehensive report that can be shared with stakeholders

Integration into System:

Integrate the designed antenna into the larger communication or electronic system. Verify
compatibility and performance in the system environment.

Field Deployment:

Conduct field tests to validate the antenna's performance in real-world conditions. Gather
feedback and make any necessary adjustments or improvements.

Maintenance and Optimization:

Develop a plan for long-term maintenance and potential future optimizations. Establish a
feedback loop for continuous improvement based on field performance and user feedback.By
following this comprehensive procedure, engineers can leverage HFSS's powerful simulation
and optimization capabilities to design antennas that meet or exceed performance requirements.
The iterative nature of the process, combined with the simulation tools provided by HFSS,

allows for efficient and effective antenna development.
RISEK
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12. Sample Antenna Design in HFSS:
Design Procedure using HFSS software:
a. Start ANSYS Electronics Desktop. Check (and change if necessary) that the working mode is
Driven Modal, HFSS > Solution Type > Modal.
b. SetModeler length units to mm, Modeler > Units > mm.

c. Todraw a dipole element, select Draw > Cylinder and enter calculated values at radius and

height position
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d. Afterdrawing the first element of the dipole we will create the second one by symmetry.
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f. To provide an input source to perform the simulation. Select Draw > Rectangle and draw



a rectangle (! it’s a surface model not a volume one) between the two wires, as in the figures

below.
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h. Select HFSS > Mode! > Create Open Region. Choose the frequency of
interest (around 900 MHz) and Radiation boundary.
i. Add asolution. Select HFSS > Analysis Setup > Add Solution Setup
j.- After meshing, we define a broadband analysis. Select the previously
defined solution (Project Manager > Analysis > Setupl) and add a
broadband solution around the frequency corresponding to the single
frequency solution HFSS > Analysis Setup > Add Frequency Sweep.
k. Select HFSS > Validation Check to verify that all required steps have been
completed.
. Select HFSS > Analyze All to start the simulation. Click the Show Progress
button to view the progress of the solver.
m. Select HFSS > Results > Create Modal Solution Data Report > Rectangular
Plot to display the S parameter corresponding to input port P1 (in dB).
n. Similarly plot far-fields parameters of the antenna.
Dr. P. Surendra Kumar demonstrated the practical application of knowledge through a sample
antenna design using HFSS. Participants engaged in hands-on exercises, applying concepts
learned during the program. The Q&A session facilitated direct interaction, allowing participants
to seek clarification on specific design aspects.
Result Analysis: The critical aspect of interpreting simulation rcsults. Participants acquired the
skills to analyze and compare simulated results with theoretical expectations. Iterative design
refinement based on result analysis was emphasized.
Certificate Program Exam: The program concluded with a comprehensive exam under the
guidance of Mr. S.V. Ravi Kumar. The exam evaluated participants on theoretical knowledge
and practical skills, covering topics from the entire program. The assessment aimed to certify
participants based on their understanding and application of the concepts learned.
Vote of Thanks: We extend our sincere gratitude to Mr. S.V. Ravi Kumar, Head of the
Department, for his visionary leadership, Dr. K.V. Subrahmanyam, Principal, for his unwavering
support, and Dr. P. Surendra Kumar, the esteemed resource person, for their invaluable
contributions to the success of the Antenna Design using HFSS Certification Program. Your
guidance and mentorship have been instrumental in shaping the learning experience for all

participants.
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RISE KRISHNA SAT GANDHI GROUP OF INSTITUTIONS
g (Approved by AICTE, New Delhi & Affiliated to INTUK, Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engincering

Date: 10-12-2021.

CLOSING REPORT

To,
The Principal,
RISE Krishna Sai Gandhi Group of Institutions.

As per the approved schedule, the ECE department has conducted a Certificate Program on
“Antenna Design using HFSS” at ECE Seminar hall from 06-12-2021 to 10-12-2021. 126
students of [V ECE have participated in this program. Dr.P.Surendra Kumar,Associate Professor,
Bapatla Engineering College, Bapatla, A.P. acted as the resource person for this program.

Main issues addressed:
1. Introduction to Antenna.
Antenna Design
Antenna Architecture
Introduction to HFSS
Antenna Design using HFSS and Result Analysis
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We are expecting your support in future also. Thanking you sir,

Yours faithfully,
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